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EPSON Ink Jet Papers

Use EPSON’s paper and inks to get the same photo quality results that have earned your printer all of 
its awards! EPSON’s papers are specially coated to work with EPSON’s quick drying inks. You’ll notice 
that when prints come out of your printer, you can immediately handle them. There is no drying time, 
no smearing or smudging, and your image is clean and smooth. Here are just a few of EPSON’s papers:

360 dpi Ink Jet Paper

Bright white coated paper for quick printing at lower resolutions with brilliant 
results. Perfect for letters, charts, clip art, and color drafts.

Photo Quality Ink Jet Paper

Acid-free, bright white, with a smooth matte finish to create your best 
impression. Perfect for presentations, newsletters, color reproductions, and all 
your photo and craft projects.

Photo Paper and Panoramic Photo Paper

Photo lab quality, heavier weight glossy paper available in a variety of 
sizes. Perfect for color photo keepsakes of snapshots, framed art, 
banners, and panoramics. 

Photo Quality Glossy Film

Durable, bright white film sheets with the highest-gloss finish. Perfect for 
printing professional quality, high-resolution photographs of all your digital 
images.

Iron-On Cool Peel Transfer Paper

Transfer your designs and photographs onto T-shirts or other cloth items. Perfect 
for ironing onto team T-shirts, canvas bags, crafts, and gifts.

See the inside back cover for a list of EPSON papers and ordering information.
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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other 
printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

Trademarks
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON CORPORATION. 

SoundAdvice is a service mark and EPSON FaxAdvice is a trademark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

CPD-8359
Copyright © 1999 by Epson America, Inc.          3/99
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Welcome!

Your EPSON Stylus® COLOR 740i printer is the ideal output device for business 
graphics, digital photographs, newsletters, and more. You can print anything from 
reports and résumés to photos and greeting cards with fabulous results. The printer 
gives you optimum photo quality using these features:

■ EPSON’s unique variable micro droplet technology for superior image quality

■ Four-color printing for photo-quality color and laser-sharp black text on plain 
paper or a variety of special media

■ Resolutions up to 1440 × 720 dpi, even on plain paper

■ Creative software

■ Fast drying times for all your photos, courtesy of EPSON’s quick-drying inks

About Your Software

The printer software CD-ROM includes all the software you need for great printing:

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t use your printer without it.

■ Your creative software includes:

■ Polaroid® PhotoMAX™ Pro, a full-featured image editing program 

■ ArcSoft™ PhotoPrinter,™ a multimedia file management program 

■ ArcSoft PhotoBase,™ a photo layout program

■ Your electronic EPSON Stylus COLOR 740i Manual gives you complete online 
information about your printer, anytime you need it.

If you haven’t yet installed your printer software from your CD-ROM, see the 
Start Here card for instructions. If you ever need to rerun the installation program, 
insert the CD-ROM and double-click the EPSON icon.
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About Your Documentation

To set up your printer and install its software, see the Start Here card. This book 
contains instructions on:

■ Viewing your electronic manual

■ Printing basic documents and selecting advanced printer settings

■ Maintaining the printer

■ Solving basic problems

■ Using your printer with Windows® (if you’re using Windows, go to page 41 to 
get started)

For more details about your printer, see the electronic EPSON Stylus COLOR 740i 
Manual. For instructions on viewing it, see page 7.

Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.
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System Requirements

To use your printer and its software, your system should have:

■ For USB connections:

■ iMac™ or Power Macintosh® G3 with built-in USB port

■ System 8.1 or later (iMac), System 8.5.1 or later(Power Macintosh G3)

Note:

If your system is running OS 8.1, you must download and install the 
iMac Update 1.0 from Apple® at http://swupdates.info.apple.com 
before you install the EPSON USB software. Contact Apple 
Computer if you have problems installing this update. If your 
system is running OS 8.5, you do not need to download and install 
the update. Your operating system already includes full support for 
the EPSON USB software.

■ Shielded USB “AB” interface cable, from Series A (computer) to Series B 
(printer), up to 6.5 feet (2 m) long.

Caution:

Using an improperly shielded USB cable—especially a cable more 
than 6.5 feet (2 m) long—may cause the printer to malfunction.

■ For serial connections:

■ One of the following Macintosh models: 
LC475, LC575, LC630; Quadra series; Centris series; PowerBook® series 
(190, 520, 540, 550, or later); PowerBook Duo 280, 2300c/100; Performa® 
475, 575, 588, 630, 5210 or later; Power Macintosh series

■ System 7.5.1 or later (7.6 or later recommended)

■ ImageWriter® II serial cable or equivalent (8-pin mini DIN male/male, Belkin 
brand recommended; EPSON part number: F2V024)

■ For all Macintosh computers:

■ At least 16MB of available RAM

■ At least 50MB of free hard disk space (100MB recommended)
■ 13-inch RGB display or better

■ Double-speed CD-ROM drive (quad-speed or faster recommended)
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ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that 
this product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR Office Equipment 
program is a voluntary partnership with the computer and 
office equipment industry to promote the introduction of 
energy-efficient personal computers, monitors, printers, fax 
machines, and copiers in an effort to reduce air pollution 
caused by power generation.

Year 2000 Ready

Your EPSON printer is Year 2000 Ready. However, be sure the other parts of your 
computer system are also ready for the year 2000. 

Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use 
the printer safely and effectively:

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. 
Do not spill liquid on the printer.

Caution:

Always turn the printer off using the 

 

Ppower button. Don’t unplug 
the printer until the 

 

Ppower light is off.

■ Do not place the printer on an unstable surface or near a radiator or heating vent.
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■ Do not block or cover the openings in the printer’s case or insert objects through 
the slots.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets 
on the same circuit as photocopiers or air control systems that regularly switch on 
and off.

■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée 
facilement.

■ Do not let the power cord become damaged or frayed.

■ If you use an extension cord with the printer, make sure the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere 
rating. Also, make sure the total ampere rating of all devices plugged into the wall 
outlet does not exceed the wall outlet’s ampere rating.

■ Except as specifically explained in this manual, do not attempt to service the 
printer yourself.

■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the 
printer has been dropped or the case damaged; if the printer does not operate 
normally or exhibits a distinct change in performance. Adjust only those controls 
that are covered by the operating instructions.

Ink Cartridge Safety Instructions

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Under normal circumstances, ink will not come out of the cartridge. If it does get 
on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Keep ink cartridges out of the reach of children.
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■ Do not dismantle the ink cartridges or try to refill them. This could result in 
damage to the print head.

■ Once you install an ink cartridge, do not open the clamp or remove the cartridge 
except to replace it with a new one. The cartridge may become unusable 
otherwise.

■ Install the ink cartridge immediately after you remove it from its foil package. 
Leaving the cartridge unpacked for a long time before use may result in reduced 
print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge package. For 
best results, use up the ink cartridges within six months of installing them.

■ Do not shake an ink cartridge; this can cause leakage.

■ Always turn the printer off using the 

 

Ppower button. When you press this 
button, the 

 

Ppower light flashes briefly then goes out. Do not unplug the printer 
or turn off the power to the printer until the 

 

Ppower light is off.

■ Before transporting the printer, make sure the print head is positioned all the way 
to the right (capped) and the ink cartridges are in place.
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Viewing Your Electronic Printer 
Manual

Here are some quick guidelines for viewing your electronic printer manual using 
Adobe Acrobat® Reader. Your creative software may also include electronic manuals; 
check their program folders or Help menu options to locate these manuals.

Note:

The electronic EPSON Stylus COLOR 740i Manual contains 
information on using the EPSON Stylus COLOR 740i printer with 
both Windows and Macintosh operating systems.

Opening Your Electronic Manual

How you open your electronic EPSON Stylus COLOR 740i Manual depends on your 
operating system and whether the manual is on your hard disk or CD-ROM drive.

If you already copied the EPSON Stylus COLOR 740i Manual to your hard disk and 
installed Acrobat Reader when you installed your printer software, locate the 
740iDOC.PDF icon in the EPManual folder on your hard drive and double-click it 
to view the manual. The manual opens in Acrobat Reader automatically.

If you haven’t copied the manual to your hard disk, insert the printer software 
CD-ROM in your CD-ROM drive. To copy the electronic EPSON Stylus COLOR 
740i Manual from your CD-ROM to your hard disk, use the Copy Manual to Hard 
Drive option in the Installer or simply drag-and-drop the 740iDOC.PDF icon from 
the Manual folder on the CD-ROM to the location of your choice.

If you don’t have Acrobat Reader, you must install it from the CD-ROM to view 
your electronic printer manual. Double-click the Acrobat Reader 3.01 Installer icon 
to install Acrobat Reader.
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Navigating an Electronic Manual

When you open an electronic manual, you’ll see this toolbar at the top:

There are several ways to navigate through electronic manuals:

■ Click on hot topics, which are usually underlined or displayed in a different color. 
To find out if a topic is hot, move your cursor over it. If the cursor turns into a 
pointing hand, the topic is hot—you can jump to it by clicking once.

■ If the manual has bookmarks, use the bookmark section on the left side of the 
screen to move quickly to the topic of your choice. Click the show bookmarks 
icon on the toolbar to see the bookmark section. (Some manuals may only have a 
table of contents that you can use to navigate the manual, if the topics are hot.)

■ Use the arrow buttons in the toolbar or the vertical scroll bar on the right side of 
the document to move through a manual. (The box to the left of the scroll bar 
displays the current page number.)

If you need more information, open Acrobat Reader’s Help menu and select the 
online guide.

next page

last page

previous page

show bookmarks first page
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Printing from Start to Finish

Here are the steps for printing a basic document on plain, letter-size paper, such as a 
memo, newsletter, or photograph—from loading the paper to selecting print settings 
to controlling print jobs. Follow the step-by-step instructions in this section.

For guidelines on loading special papers and envelopes, and for selecting the correct 
Media Type setting for them, see page 11.

For instructions on customizing your settings to fine-tune your printouts, see page 15.

For guidelines on preserving photos, see page 18.

Printing with a Macintosh

1. Make sure your printer and Macintosh are turned on.

2. Load a stack of plain paper and place it against the right edge guide. Then slide 
the left edge guide against the paper’s left edge, making sure the stack is lower 
than the arrow on the guide. If you are using letterhead or preprinted paper, be 
sure the top of the paper feeds into the printer first.

3. Open an application program and select a document to print.

slide paper against the 
right edge guide

load paper only 
up to this arrow
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4. Open the File menu and choose Page Setup (Document Setup in some 
applications). You see a Page Setup dialog box like this:

5. Choose your paper size, page orientation, and printable area settings. Then 
click OK.

6. Now open the File menu and choose Print. You see the main printer settings 
dialog box:

7. Check the following settings:

■ Make sure the Media Type is set to Plain Paper. (If you load a different type 
of paper, select the corresponding setting for it, as described on page 14. For 
instructions on loading special paper, see page 11.)

■ Make sure Ink is set to Color if you want to print in color.

■ Set the Mode option to Automatic. This is the easiest way to get good 
printing results for all kinds of documents, on all types of paper.

■ Move the Quality/Speed slider to the Quality setting. This selects a high 
quality setting for the paper you’re using. (The slider is not available for some 
media types. You can use a higher resolution on some papers on the Advanced 
dialog box; see page 16 for instructions.)

Paper Size 
setting

Automatic 
mode setting

Quality/Speed 
slider

Media Type setting Ink setting
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8. Click the Layout icon to reduce or enlarge your image, print multiple layouts, 
or add a watermark.

Click the Background Printing icon to prioritize printing of your print job. 

Click the Preview icon to preview your printout.

9. Click Print to start printing. If you turned on background printing, you see the 
EPSON Monitor3 dialog box to show you the print job’s progress. You can 
cancel , pause , or restart your print job as necessary.

For more information on printing, see the electronic EPSON Stylus COLOR 740i 
Manual. See page 7 for instructions on viewing the manual.

Using EPSON Special Papers

How can you get the best-looking photos, most vivid colors, 
and sharpest text? Always use EPSON’s special ink jet papers. 
To show you how much difference EPSON paper can make, 
we’ve included some free samples.

Check out the EPSON Photo Quality Media Pack that came 
with your printer. Then follow the instructions below to print 
your favorite photos and documents on EPSON paper.

See the inside back cover for a list of EPSON papers and ordering information. For 
complete instructions on using all of EPSON’s special ink jet papers, see the 
electronic EPSON Stylus COLOR 740i Manual.

job currently 
printing

jobs queued 
for printing

click to set priorities for waiting print jobs
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EPSON Photo Paper

You can use EPSON Photo Paper to print photographs that look almost as good as 
the ones you get from film processing. Photo Paper is available in 4 × 6-inch, letter, 
A4, and Panoramic (8.3 × 23.4 inches) paper sizes. Your Media Pack includes samples 
of 4 × 6-inch and letter-size paper. 4 × 6-inch Photo Paper is perforated around the 
edges, so you can trim your printouts and “bleed” the photo—extend it to the edge of 
the paper—on all sides. 

You can load up to 20 sheets of 4 × 6-inch or letter-size Photo Paper. Make sure you 
place a support sheet beneath the paper if it is included in the paper package.

Keep the following in mind when using EPSON Photo Paper:

■ Load the paper with the whiter (glossier) side facing up. 

■ Select Photo Paper as the Media Type setting

■ Select the correct Paper Size setting for the paper you’re using.

For details on preserving your photographs printed on Photo Paper, see page 18.

If you’re loading 4 × 6-inch Photo Paper, follow these steps:

1. Position the perforated margins as shown 
and load up to 20 sheets with support 
sheets A and B beneath the stack.

2. When you create the image you’ll 
print in your application software, 
size it to 4.25 × 6.25 inches so the image 
covers the perforations as shown below:

trim size

printed 
image size
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3. Choose the following settings:

■ Photo Paper as the Media Type setting

■ EPSON Photo Paper 4 × 6 in as the Paper Size setting

■ Maximum as the Printable Area setting

4. After you print, fold the paper back and forth along the 
perforations and carefully tear the margins off.

EPSON Photo Quality Ink Jet Paper

This low-cost paper makes all your 
printouts look their best. Load the paper 
only up to the arrow on the left edge guide 
and choose Photo Quality Ink Jet Paper as 
the Media Type setting in your printer 
software.

Envelopes

You can print on just about any kind of envelope. 
Load up to 10 at a time, flap edge first, with the 
printable side up.

You may get better results if you press each envelope 
flat before loading it, or try loading one envelope at a 
time.

Select Plain paper as the Media Type setting and select 
the correct envelope size in your printer software.

Set the paper thickness lever to the 
+ position. (Return the lever to the 
0 position before you print on regular 
paper.)

load paper only 
up to this arrow
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Choosing the Right Settings for EPSON Papers

Your printer automatically adjusts itself for the type 
of paper you select in your printer software. That’s 
why the Media Type setting is so important. It tells 
your printer what kind of paper you’re using and 
adjusts the ink coverage accordingly. 

Before you print, always check your Media Type 
setting. Here are the settings you should choose for 
your paper:

Caution:

If any paper you buy comes with a cleaning sheet, don’t use the 
cleaning sheet with this printer; it may jam inside the printer.

For this paper . . . Select this Media Type setting . . .

Plain paper sheets or envelopes Plain paper

EPSON 360 dpi Ink Jet Paper

EPSON Iron-On Cool Peel Transfer Paper

360 dpi Ink Jet Paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Photo Paper

EPSON Photo Quality Glossy Paper

Photo Paper

EPSON Photo Quality Glossy Film

EPSON Photo Stickers

Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing with Custom Settings

Your EPSON Stylus COLOR 740i printer software includes convenient project type 
settings for printing specific types of documents or images—such as photographs, 
graphics, text, and drafts—and a variety individual custom settings to fit your needs. 

When you use custom settings, you can choose to either:

■ Use custom project types, or

■ Customize your individual settings.

Using Custom Project Types

When you’re printing a particular type of document and want to quickly select the 
best settings for your type of paper, you can use custom project types in your printer 
software. Some project types may not be available, depending on your operating 
system and the Media Type and Ink settings you choose.

1. Open an application and create your project. Then open the File menu and 
choose Print. You see the main printer settings dialog box.

2. Select the correct Media Type setting for your paper and choose Color or Black 
Ink.

3. Click the Custom button, then click the Custom Settings list. You see a list of 
custom project types. Select one of the types listed on the next page.

click Custom, then click here to see a list of project types
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■ PhotoEnhance3 
For printing images captured using a video camera, digital camera, or scanner. 
Automatically adjusts the contrast, saturation, and brightness and corrects 
overall under- or over-exposure of the original image.

■ Digital Camera
For printing images captured using a scanner or digital camera. Corrects noise 
and other common flaws.

■ Text/Graph
For printing graphics-intensive documents like presentations with charts and 
graphs. Intensifies colors and lightens the midtones and highlights.

■ Text
For fast printing of text-only documents on plain paper.

■ Economy
For rough drafts of text on plain paper. Saves ink. 

■ ColorSync
Automatically adjusts printout colors to closely match the colors on your 
screen; see your electronic EPSON Stylus COLOR 740i Manual for details.

4. Select any other settings you need to change in the printer software, then click 
Print to print your document.

Customizing Print Settings

For maximum control over your project, you can customize your print settings and 
experiment with special effects and color management. You can even save your 
custom settings as a group so you can use them whenever you print a similar project.

1. Open an application and create your project. Then open the File menu and 
choose Print. You see the main printer settings dialog box.

2. Select the correct Media Type setting for 
your paper and choose Color or Black 
Ink.

3. Click the Custom button, then click 
the Advanced button. You see the 
Advanced dialog box shown to the right:
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4. On the Advanced dialog box, you can customize these settings:

■ Media Type and Ink
These settings are the same as the ones you selected on the main printer 
settings dialog box. You can change them here as you customize your settings, 
if needed.

■ Print Quality
Selects the print resolution you want to use, from Economy to Photo-1440 
dpi, depending on what’s available for the Media Type you selected and 
whether you want to print a draft or a finished document.

■ Halftoning
Selects the method you want to use for printing the dot patterns in your 
images. For photographs, select Error Diffusion; for graphs or other images 
with precise edges, select Fine Dithering.

■ MicroWeave, High Speed, Flip Horizontal, and Finest Detail
MicroWeave deters horizontal banding by printing in finer increments.

High Speed enables bidirectional printing for fast output.

Flip Horizontal creates a mirror image of your document for iron-on transfers.

Finest Detail produces exceptionally sharp image edges, but slows down 
printing.

■ Color Adjustment, PhotoEnhance3, and ColorSync
Color Adjustment mode lets you choose just the level of adjustment you need, 
from Automatic mode to No Color Adjustment (for using other color 
management software). You can also individually adjust the levels of 
Brightness, Contrast, and Saturation, and increase or decrease the amount of 
Cyan, Magenta, and Yellow inks used to print your image.

PhotoEnhance3 produces sharper digital images with more vivid colors by 
automatically adjusting the brightness, contrast, and saturation, and 
correcting for overall under- or over-exposure of the image. Use the example 
photograph on the screen to help you adjust the Tone of your photo or 
correct common digital image flaws using Digital Camera Correction mode 
and the Sharpness button.
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ColorSync color correction settings, used in conjunction with compatible 
devices and software, can help you match the image colors you see on your 
monitor screen with those printed out on your printer. You must set up your 
operating system, devices, and other software before printing with these 
settings for best results.

5. Once you’ve customized your settings, you can save them as a group so you can 
use them again later. If you want to save your settings, click Save Settings in the 
Advanced dialog box. Type a name for your setting group (up to 16 characters) 
and click OK.

(To use your saved custom setting group, just select it from the Custom Settings 
list on the main printer settings dialog box, as described on page 15.)

6. Select any other settings you need to change in the printer software, then click 
Print to print your document.

For complete instructions on using all your printer software’s custom settings, see the 
electronic EPSON Stylus COLOR 740i Manual.

Preserving Photos on EPSON Photo Paper

EPSON Photo Paper has been specially formulated to work with EPSON’s ink to 
create prints that last as long as traditional photographs when protected from light in 
photo albums or similar archival conditions.

When you display your EPSON Photo Paper prints in picture frames or mounted on 
the wall, the paper provides extra UV (ultraviolet) light protection so your prints will 
last longer than prints on other ink jet photo papers. Depending on the type and 
intensity of the light your print is exposed to, a print on EPSON Photo Paper may 
last two or more years before noticeable fading occurs. Fade resistance could decrease 
in intense light conditions or increase if your print is protected by glass or special 
laminates.

For optimum results and longer print life, print your digital photos on EPSON Photo 
Paper. See the inside back cover of this manual for a list of available paper sizes.
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Maintaining Your Printer

These sections describe the most common maintenance procedures you’ll need to 
perform to keep your printer working well and to prepare it for moving: 

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 22

■ “Aligning the Print Head” on page 28

■ “Cleaning the Printer” on page 29

■ “Transporting the Printer” on page 30

For more details, see your electronic EPSON Stylus COLOR 740i Manual as described 
on page 7.

Cleaning the Print Head

If your printed image is unexpectedly light or faint, or dots are missing from the 
image, you may need to clean the print head. This unclogs the nozzles so they can 
deliver ink properly.

Cleaning the print head uses ink, so clean it only if print quality declines. You can 
clean the print head in either of the following ways:

■ With the Head Cleaning utility in your printer software (when connected to a 
local port, not over a network), as described on the next page

■ Using the printer’s control panel buttons, as described on page 21
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Using the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the 

 

B black and 

 

A color 
ink out lights are off.

2. Start an application and open a document.

3. Open the File menu and choose Print. You see the main printer settings dialog 
box.

4. Click the Utility icon. You see 
the Utility menu shown to the 
right:

5. Click the Head Cleaning icon.

Follow the instructions on the 
screen to clean the print head. 
Cleaning takes a little over a 
minute, during which the printer 
makes some noise and the 

 

Ppower 
light flashes.

Caution:

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.

6. When the 

 

Ppower light stops flashing, run a nozzle check to test the results and 
reset the cleaning cycle.

Make sure paper is loaded in the printer and click Confirmation. Then click Next. 
The nozzle check pattern prints; see page 22 for details.

7. If the nozzle check pattern is filled in completely, click Finish.

If the pattern is missing dots, click Clean to run another cleaning cycle. If you 
don’t see any improvement in the print quality after cleaning two or three times, 
check the solutions on page 36.

Head Cleaning utility
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Using the Control Panel

1. Make sure the printer is turned on but not 
printing, and the 

 

B black and 

 

A color ink 
out lights are off. 

2. Press the 

 

R cleaning button and hold it 
down for 3 seconds. Cleaning takes a little 
over a minute, during which the printer 
makes some noise and the 

 

Ppower light 
flashes.

Caution:

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.

3. After the 

 

Ppower light stops flashing, print a page to test the print quality and 
reset the cleaning cycle.

If you’re connected directly to the printer, run a nozzle check. Go to step 4.

If you’re printing over a network, open an application and print a document 
containing black and color data. Then go to step 8.

4. Start an application, open a document, and access the printer settings dialog box 
as described on page 9. 

5. Click the Utility icon. You see the Utility menu.

6. Make sure paper is loaded in the printer, click the Nozzle Check icon, and click 
Next. The nozzle check pattern prints; see page 22 for details.

7. If the nozzle check pattern is filled in completely, click Finish. If the pattern is 
missing dots, click Clean to clean again.

8. If you don’t see any improvement in the print quality after cleaning two or three 
times, check the solutions on page 36.

cleaning button
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look something like this:

Each staggered horizontal and straight vertical line should be complete, with no gaps 
in the dot pattern. If your printout looks okay, you’re done. If any dots are missing, as 
shown to the right, clean the print head again; see page 19 for instructions.

Replacing an Ink Cartridge

When the 

 

B black or 

 

A color ink out light flashes, the indicated cartridge is low on 
ink. This is a good time to make sure you have a new cartridge. When the light stays 
on, the cartridge is empty and you need to replace it.

When you need new ink cartridges, contact your dealer or call EPSON Accessories at 
(800) 873-7766 or visit our web site at www.epsonsupplies.com (U.S. sales only). In 
Canada, please call (800) 873-7766 for dealer referral.

Missing dots
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Use these EPSON ink cartridges within 6 months of installing them and before the 
expiration date on the package:

Black ink cartridge: S020189
Color ink cartridge: S020191

Caution:

To ensure good results, use genuine EPSON ink cartridges and do 
not refill them. Other products may cause damage to your printer 
not covered by EPSON’s warranty.

If you need to replace an ink cartridge before the lights flash (because the ink is too 
old, for example), follow the instructions on page 26.

Removing and Installing Ink Cartridges

You can replace a cartridge when the 

 

B black or 

 

A color ink out light is either 
flashing or on. 

If you perform these steps when both ink out lights are off, the printer cleans the print 
head, as described in “Cleaning the Print Head” on page 19.

1. Remove the new ink cartridge from its packaging.

2. Remove only the yellow part of the tape seal on top as shown below. 

Caution:

You must remove the yellow tape from the top of the cartridge or 
you will permanently damage it. Don’t pull off the blue portion or try 
to remove the clear seal underneath the cartridge.

black cartridge color cartridge
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3. Make sure the printer is turned on and not printing, then open the printer cover.

4. Press the 

 

R cleaning button and hold it for about 3 seconds until the print head 
moves left and the 

 

Ppower light begins flashing. 

(The print head returns to its home position if you don’t proceed to step 5 within 
60 seconds.)

Caution:

To avoid damaging the printer, never move the print head by hand.

Don’t open the clamp or remove a cartridge except to replace it 
with a new one. Once you remove a cartridge, you can’t reuse it, 
even if it contains ink.

5. Pull up the ink cartridge clamp. The cartridge rises up from its holder.

6. Lift the cartridge out of the printer and dispose of it carefully.

Warning:

If ink gets on your hands, wash them thoroughly with soap and 
water. If ink gets into your eyes, flush them immediately with 
water.
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7. Lower the new ink cartridge into its holder with the label facing up and toward 
the back of the printer.

8. Press down the ink cartridge clamp until it locks in place.

9. If you need to replace the other ink cartridge, repeat steps 5 through 8 before 
going on to step 10.

10. Press the 

 

R cleaning button and close the printer cover. 

The printer moves the print head and begins charging the ink delivery system. 
(Even if you don’t press the button, ink charging begins 60 seconds after you close 
the clamp.) 

The 

 

Ppower light flashes, and the printer makes various sounds. Charging takes a 
couple of minutes. When it’s finished, the 

 

Ppower light stops flashing and stays 
on.

Caution:

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.
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Replacing an Outdated Ink Cartridge

If an ink cartridge is more than 6 months old, you may need to replace it. How can 
you tell? You may notice that your printouts don’t look as good as they used to. If 
print quality doesn’t improve after cleaning and aligning the print head, you can 
replace one or both cartridges.

Follow these steps to replace an ink cartridge before the 

 

B black or 

 

A color ink out 
light is flashing or on:

1. Remove the new ink cartridge from its packaging.

2. Remove only the yellow part of the tape seal on top as shown below. 

Caution:

You must remove the yellow tape from the top of the cartridge or 
you will permanently damage it. Don’t pull off the blue portion or try 
to remove the clear seal underneath the cartridge.

3. Make sure the printer is turned on and not printing, then open the printer cover.

4. Press the 

 

E load/eject button and hold it down for 3 seconds until the print head 
moves to the left and the 

 

Ppower light begins flashing.

Caution:

To avoid damaging the printer, never move the print head by hand.

black cartridge color cartridge
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5. Pull up the ink cartridge clamp. The cartridge rises up from its holder.

Caution:

Don’t open the clamp or remove a 
cartridge except to replace it with 
a new one. Once you remove a 
cartridge, you can’t reuse it, even 
if it contains ink.

6. Lift the cartridge out of the printer and 
dispose of it carefully.

Warning:

If ink gets on your hands, wash them thoroughly with soap and 
water. If ink gets into your eyes, flush them immediately with 
water.

7. Lower the new ink cartridge into its holder 
with the label facing up and toward the 
back of the printer.

8. Press down the ink cartridge clamp 
until it locks in place.

9. If you need to replace the other ink 
cartridge, repeat steps 5 through 8 before 
going on to step 10.

10. Press the 

 

E load/eject button and close the printer cover.

The printer moves the print head and begins charging the ink delivery system. 
The 

 

Ppower light flashes and the printer makes various sounds. Charging takes a 
couple of minutes. When it’s finished, the 

 

Ppower light stops flashing and stays 
on.

Caution:

Never turn off the printer while the 

 

Ppower light is flashing, unless 
the printer hasn’t moved or made noise for more than 5 minutes.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to use the Print 
Head Alignment utility in your printer software. Your printer must be connected
to a local port, not on a network, to use the Print Head Alignment utility. Follow 
these steps:

1. Make sure the printer is turned on and paper is loaded.

Caution:

Load paper that’s at least 8.27 inches (210 mm) wide. This prevents 
ink from spraying inside the printer and smudging your printouts. 
For the best results, load EPSON ink jet paper in the printer 
whenever you check the print head alignment.

2. Start an application and open a document.

3. Open the File menu and choose Print. You see the main printer settings dialog 
box:

4. Click the Utility icon. You see the Utility menu.

5. Click the Print Head Alignment icon.

6. Follow the instructions on the screen to print a test page.

7. Select the most precise alignment pattern from the printed choices on the test 
page. Enter the number of the best aligned pattern following the instructions on 
the screen.

Utility icon
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Cleaning the Printer

To keep your printer working well, you should clean it as follows several times a year:

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 

4. Clean ink out of the printer’s interior with a soft, damp cloth.

Caution:

Don’t touch the gears inside the printer.

Never use alcohol or thinner for cleaning; they can damage the 
printer components and case.

Don’t use a hard or abrasive brush.

Don’t get water on the printer components or spray lubricants or 
oils inside the printer.
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation and 
repack it in its original box. Follow these steps:

1. Turn on the printer and wait until the print head locks in the far right position. 
Then turn off the printer.

Caution:

To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

2. Unplug the power cord, then disconnect the interface cable from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box using the protective 
materials that came with it. See the unpacking sheet that was packed with your 
printer.

Be sure to keep the printer level as you transport it. If you notice a decline in print 
quality after transporting the printer, clean the print head (see page 19); if output is 
misaligned, align the print head (see page 28). 
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Problem Solving

This section gives you the basics for diagnosing and solving printer problems. 

■ First see “Diagnosing Printer Problems” below to help determine what the cause 
of the problem may be. 

■ Then see page 34 for solutions to common problems.

It’s a good idea to check EPSON’s web site periodically for possible 
updates to your printer driver. Visit www.epson.com and check the 
section for your product to see if there is a new driver available for 
downloading to your computer.

Diagnosing Printer Problems

You can diagnose some problems by checking the printer’s control panel lights, as 
described below. It may also be helpful to try running a printer operation check; see 
page 33 for instructions.

Checking the Control Panel Lights

power 
button

load/eject buttoncleaning button

paper out light

color ink out light

black ink out light

power 
light
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Follow these guidelines when the control panel lights come on or flash:

 

P is on The 

 

P power light is on when the printer is on and ready to print. It 
flashes when the printer is receiving a print job or performing a 
maintenance operation, such as cleaning the print head.

 

S flashes When the 

 

S paper out light flashes, paper is jammed in the printer. 
Turn off the printer and gently pull out all paper. Make sure none of 
the sheets are curled, creased, old, stuck together, or too thin. Then 
reload the stack against the right edge guide and slide the left edge 
guide over to the paper’s left edge. Turn on the printer and press the 

 

E load/eject button.

 

S is on When the 

 

S paper out light comes on, your paper ran out or is 
incorrectly loaded. Make sure none of the sheets are curled, creased, 
old, stuck together, or too thin. Then reload the stack against the 
right edge guide and slide the left edge guide over to the paper’s left 
edge. Press the 

 

E load/eject button.

 

B

 

 or 

 

A flash When an ink out light flashes, your ink supply is low. Make sure you 
have a replacement cartridge.

 

B

 

 or 

 

A are on When an ink out light comes on, you need to replace the ink 
cartridge. See page 22 for instructions.

 

P and 

 

S flash, and

 

B and 

 

A are on
When the 

 

P power and 

 

S paper out lights flash and the 

 

B black and 

 

A color ink out lights come on, jammed paper may be blocking 
movement of the print head. Turn off the printer, wait a few seconds, 
and turn it back on. If no paper ejects, turn off the printer, remove the 
jammed paper, and turn it on again. If the lights still flash or stay on, 
contact your dealer or EPSON; see page 39 for contact information.

 

P 

 

S

 

 

 

B

 

 

 

A flash When all the lights flash, your printer may have an internal error. 
Make sure you removed all the packing material as described on the 
unpacking sheet in your printer box. Then turn off the printer, wait a 
few seconds, and turn it on again. If the lights still flash or stay on, 
contact your dealer or EPSON; see page 39 for contact information.

 

P 

 

S

 

 

 

B

 

 

 

A are off When all the lights are off, the printer is not receiving power. Try 
these solutions:

■ Make sure the printer is turned on.

■ Turn off the printer, plug in the power cord securely, and turn on 
the printer again.

■ Make sure the outlet is operable and not controlled by a switch 
or timer. Try using another outlet.
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Running a Printer Operation Check

You can run a printer operation check to determine whether the problem comes from 
the printer or some other source.

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the printer.

Caution:

Load paper that’s at least 8.27 inches (210 mm) wide. This prevents 
ink from spraying inside the printer and smudging your printouts.

4. Hold down the 

 

E load/eject button 
and press the 

 

Ppower button. 
Continue holding down the 

 

E load/eject button until the 

 

Ppower 
light starts to flash, then release it.

The printer prints its ROM version 
number and a nozzle check pattern 
(shown on page 22).

5. After it prints the check page, turn off 
the printer. Then reconnect the interface cable and turn on your printer and 
computer.

If the results are satisfactory, the problem lies in your software settings, the interface 
cable, or your computer.

If the check page does not print correctly, you may have a problem with your printer. 
See the suggestions on page 34 for more information.

power 
button

load/eject button

power 
light
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Problems and Solutions

Here are some basic troubleshooting tips if you have any problems:

■ Setting up your printer or installing software

■ Getting good print quality

For more extensive information, check the online help in your printer software or see 
“Troubleshooting” in the electronic EPSON Stylus COLOR 740i Manual. If none of 
the suggested solutions solve your problem, see page 39 for help contact information.

Problems Setting Up the Printer or Installing Its 
Software

You installed the ink cartridges 
and the printer started making 
noise . . .

■ The first time you install ink 
cartridges, the printer charges its 
ink delivery system for a couple 
of minutes. Please wait until 
charging is finished (the 

 

Ppower 
light stops flashing) before you 
turn off the printer. If you turn 
off the printer while it’s charging, 
it begins charging again and uses 
more ink than necessary when 
you turn it back on. See the Start 
Here card for details.

■ Make sure the ink cartridge 
clamps are locked down 
completely and that no packing 
material remains in the printer.

You’re having problems installing 
the printer software . . .

■ Carefully follow the instructions 
for installing the printer software 
on the Start Here card, making 
sure your printer is turned on and 
the interface cable is securely 
connected at both ends.

■ If you still have problems, close 
all other applications, including 
anti-virus programs and screen 
savers. Then try installing the 
software again.
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Your printer icon doesn’t appear 
in the Chooser . . .

■ Your Macintosh has extension 
conflicts. Disable Quick Draw 
GX in the Extensions Manager. 
Make sure EPSON Monitor3 
and SC 740 are enabled, and then 
restart your Macintosh.

■ You may have too many items in 
the Chooser. Delete or move any 
unused items and check the 
Chooser again.

You need help with the creative 
software on your CD-ROM . . .

■ For installation instructions, see 
the Start Here card.

■ For assistance using the 
programs you installed from 
the CD-ROM, contact the 
company that produced the 
software. For contact 
information, see page 40.

Your printer makes noise when 
you turn it on or after it has been 
sitting for a while . . .

Your printer is performing routine 
maintenance. Wait until it stops 
making noise before printing.

If you need to uninstall the printer 
software . . .

If you need to uninstall and then 
reinstall your printer software, follow 
these steps:

1. Insert the printer software 
CD-ROM in your drive.

2. Double-click the EPSON icon. 
After a moment, you see the 
EPSON Stylus COLOR 740i 
Installer Main Menu.

3. Click Re-install Printer Driver, 
then click the same button on the 
next screen.

4. If the driver installation title 
screen appears, click Continue.

5. On the Printer Driver Installer 
screen, click the arrow in the list 
at the top showing Easy Install, 
and select Remove from the list.

6. Click the Remove button on the 
bottom of the screen.

7. Follow the instructions on the 
screen to uninstall the printer 
software. Then restart your 
Macintosh.

8. To reinstall your software, see the 
Start Here card.
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Problems Getting Good Print Quality

If you see horizontal banding . . .

■ Make sure the print head nozzles are 
not clogged. To clean the print 
head, see page 19.

■ Make sure the Media Type setting 
matches the paper you loaded. See 
page 14 for guidelines.

■ Make sure the printable side of the 
paper is face up. It is usually the 
whiter or shinier side of ink jet 
paper.

■ Make sure the ink cartridges aren’t 
low on ink. If either ink out light is 
flashing, replace the ink cartridge; 
see page 22. If your ink cartridge is 
more than six months old, you may 
need to replace it; see page 26.

■ Try using Automatic mode. See 
page 10 for instructions.

■ For most papers, set the paper 
thickness lever to the 0 position to 
prevent banding, as shown to the 
right. Set it to the + position for 
thicker paper or envelopes.

If you see vertical banding . . .

■ Make sure the print head nozzles are 
not clogged. To clean the print 
head, see page 19.

■ Run the Print Head Alignment 
utility. See page 28 for instructions.

■ Check the paper thickness lever 
position. If it’s in the + position, 
your printer is set for thicker paper 
or envelopes and your image may 
have banding. For most papers, set 
the paper thickness lever to the 0 
position.
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If your printout is blurry or 
smeared . . .

■ Make sure your paper isn’t damp or 
loaded face down (the printable side 
should be loaded face up). If it’s 
damp, reload a new stack of paper.

■ Use a support sheet with special 
media or try loading your media 
one sheet at a time.

■ Check the paper thickness lever 
position. If it’s in the + position, 
your printer is set for thicker paper 
or envelopes and your image may 
smear. For most papers, set the 
paper thickness lever to the 0 
position, as shown on the facing 
page.

■ Make sure your paper or media 
meets the specifications listed in 
your electronic EPSON Stylus 
COLOR 740i Manual.

■ Run the Print Head Alignment 
utility. See page 28 for instructions.

If your printout contains incorrect 
characters . . .

■ Your printer’s interface cable may
not be securely connected. Check 
that the cable is securely connected
at both ends to ensure proper 
communication between your
printer and computer. After 
adjusting the cable, try printing
from an application again.

■ Your printer may not be selected
as the current printer in the 
Chooser.

To select your printer in the 
Chooser, see the Start Here card.

■ Make sure your USB cable meets the 
requirements listed on page 3.
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If your printout is faint or has gaps 
in the image . . .

■ Make sure the print head nozzles are 
not clogged. To clean the print 
head, see page 19.

■ Make sure your paper isn’t 
damaged, old, dirty, or loaded face 
down (the printable surface should 
be loaded face up). If it is, reload a 
new stack of paper with the 
printable side up.

If your printout is grainy . . .

■ Try using a higher quality paper.

■ Make sure you set the 
Quality/Speed slider to the Quality 
setting in your printer software; see 
page 10 for instructions.

■ Run the Print Head Alignment 
utility. See page 28 for instructions.

■ You may need to increase the image 
resolution or print it in a smaller 
size. See your application software 
documentation for instructions.

If your printout contains incorrect or 
missing colors . . .

■ Make sure the Ink setting is set to 
Color for color images.

■ Make sure the print head nozzles are 
not clogged. To clean the print 
head, see page 19.

■ Make sure the ink cartridges aren’t 
low on ink or too old. If either ink 
out light is flashing, replace the ink 
cartridge; see page 22. If your ink 
cartridge is more than six months 
old, you may need to replace it; see 
page 26.

■ Try using Automatic mode. See 
page 10 for instructions.

■ Your printed colors can never 
exactly match your on-screen colors. 
However, you can use a color 
matching scheme to get as close as 
possible. For information on your 
printer software’s color matching 
options, see page 16.
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Where To Get Help

If you need help with your printer or its software, see the contact information in the 
next section. For help with any of the creative applications on the printer software 
CD-ROM, see page 40 for contact information.

EPSON Technical Support

EPSON provides technical assistance through electronic support services and 
automated telephone services 24 hours a day, shown in the following tables:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com.

EPSON Internet FTP 
Site

If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto 
ftp.epson.com with the user name anonymous and your 
e-mail address as the password.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.

Automated telephone services

Service Access

EPSON 
SoundAdviceSM

For pre-recorded answers to commonly asked questions about 
EPSON products 24 hours a day, seven days a week, call 
(800) 922-8911.

EPSON FaxAdviceTM Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to use 
this service.

EPSON Referral 
Service

For the location of your nearest Authorized EPSON Reseller or 
Customer Care Center, call (800) 922-8911.
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To speak to a technical support representative, dial (310) 974-1188 U.S. or 
(905) 709-2567 Canada. Toll or long distance charges may apply. 

Technical support representatives are available 6 AM to 6 PM, Pacific Time, Monday 
through Friday and 7 AM to 4 PM, Saturday.

Before you call, please have the following information ready:

■ Product name (EPSON Stylus COLOR 740i)

■ Product serial number (located on the back of the printer)

■ Computer configuration

■ Description of the problem

If you need help using another manufacturer’s software with an EPSON product, 
see the documentation for that software for technical support information.

You can purchase ink cartridges, paper, manuals, and accessories from EPSON 
Accessories at (800) 873-7766 or visit our web site at www.epsonsupplies.com 
(U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral.

Creative Software Technical Support

For technical support on any of the creative applications on the printer software 
CD-ROM, contact the software manufacturer as described below.

Contact method

Polaroid PhotoMax Pro

ArcSoft PhotoBase

ArcSoft PhotoPrinter

Telephone (510) 440-9901, 8:30 AM to 5:30 PM Pacific Standard Time

Fax (510) 440-1270

E-mail support@arcsoft.com

Web site http://www.arcsoft.com

Mail ArcSoft Technical Support
46601 Fremont Blvd.
Fremont, CA 94538
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Using Your Printer with Windows

In addition to the iMac and Power Macintosh G3, you can use your EPSON Stylus 
COLOR 740i printer with Windows. See the instructions in this section.

Windows System Requirements

To use your printer and its software with a PC, your system should have: 

■ An IBM® compatible PC with at least a 386/25 (for Windows 3.1x), 
486/25 MHz (for Windows 95 or Windows NT 4.0), or 486/66 MHz (for 
Windows 98) processor

■ Microsoft® Windows 3.1, Windows 95, Windows 98, or Windows NT 4.0

■ At least 16MB of RAM (32MB for Windows 95 or 98 or 64MB for 
Windows NT 4.0 recommended)

■ At least 50MB of free hard disk space (100MB recommended)

■ VGA, Super VGA, or better display adapter and monitor

■ Double-speed CD-ROM drive (quad-speed or faster recommended)

■ For USB connection to a computer running Windows 98 with a Windows 98 
compliant USB port, a shielded USB “AB” interface cable, from Series A 
(computer) to Series B (printer), up to 6.5 ft. (2.0 meters) long.

Caution:

Using an improperly shielded USB cable—especially a cable more 
than 6.5 ft. (2.0 meters) long—may cause the printer to 
malfunction.

For parallel connection, a high-speed, bidirectional, IEEE-1284 compliant 
parallel cable (6 to 10 feet long); the cable must have a D-SUB, 25-pin, male 
connector for your computer and a 36-pin, Centronics® compatible connector for 
the printer.
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Connecting the Printer

USB Connection (Recommended connection; for Windows 98 only)

Caution:

If you’re using a USB hub, connect the printer’s cable to the first 
tier of the hub or the printer may malfunction. If the printer doesn’t 
work with the hub, connect it directly to the USB port.

1. Turn off the printer and computer.

2. Plug the square connector on the USB cable into the USB connector 
on the back of the printer. Then plug the flat connector into the USB 
port on your computer or USB hub.
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Parallel Connection

1. Turn off the printer and computer.

2. Connect the parallel cable to the printer’s parallel connector, then fasten it with 
the wire clips.

3. Connect the other end of the cable to your computer’s main parallel connector 
(LPT1) and secure it as necessary.

Note:

The printer software automatically assigns the printer to the LPT1 
port. To use a different LPT port, see your Windows documentation 
for instructions.
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Installing the Printer Software

Follow the instructions for your operating system and cable connection.

Windows 98 with USB Connection

Installing the USB and Printer Driver Software

1. Make sure your printer and computer are connected and turned off.

2. Turn on your computer and wait until you see the Windows 98 desktop icons.

3. Turn on your printer. You see the Add New Hardware Wizard screen:

4. Insert the printer software CD-ROM in your drive, then click Next. 

5. Select Search for the best driver for your device and click Next.

6. Select Specify a location and type 
D:\DRIVERS\WIN98 (where D is your 
CD-ROM drive letter). Then click Next.

Windows 98 
first detects a 
USB printer and 
installs a device 
driver for it
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7. The Add New Hardware Wizard now displays EPSON USB Printer; click Next.

8. The installer copies the USB printer files to your system. At the final screen, click 
Finish.

9. Windows 98 detects your printer and displays the following screen. Click Next to 
install your printer driver.

10. At the next screen, select Search for the best driver for your device and click 
Next.

you see your 
printer model 
name here

you see your 
printer model 
name here
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11. Select Specify a location and, if necessary, 
type D:\DRIVERS\WIN98 (where D is your 
CD-ROM drive letter). Then click Next.

12. Follow the on-screen instructions to install 
your printer driver. Be sure to click the Yes 
radio button to set your printer as the 
Windows default printer. At the last 
screen, click Finish.

13. Now you’re prompted to install Status Monitor 2. Follow the on-screen 
instructions to install Status Monitor 2 and restart your system.

Installing Your Creative Software and Electronic Manual

Once you’ve restarted your system, you can install the rest of the software on your 
EPSON CD-ROM from the Start menu.

1. Make sure the EPSON CD-ROM is in your drive.

2. Click Start, select Run, and type D:\EPSON (where D is your CD-ROM drive 
letter). Then click OK.

3. Read the license agreement, then click Agree. 
After a moment, you see the EPSON Stylus 
COLOR 740i Installer Main Menu:

4. To install a program or your electronic 
EPSON Stylus COLOR 740i Manual, just 
click the button for your selection on the 
Main Menu. (If necessary, close any open 
windows covering the Main Menu.)

Note:

When you view your electronic manual, the installer automatically 
installs Adobe Acrobat Reader, if necessary. Once you’ve viewed 
the manual, you can copy it to your hard disk by selecting the Copy 
Printer Manual to Hard Drive option.
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5. Some of the software you install may restart your system. If you restart but want 
to install more software, click Start, point to Programs, Epson, and select 
EPSON Stylus COLOR 740i Installer to return to the Main Menu.

6. After you finish installing software, you’re ready to print a color image! See 
page 51 to get started.

Windows 95, 98, and NT 4.0 with Parallel 
Connection

1. Make sure your printer and computer are connected and turned off.

2. Turn on your computer and wait until you see the icons on your Windows 
desktop.

3. Turn on your printer and wait until the 

 

Ppower light stops flashing.

IMPORTANT:

If at any time you see a screen telling you that Windows has detected your 
printer and asking you to install a driver diskette, ALWAYS select Cancel. You 
can’t install your software that way.

4. Insert your printer software CD-ROM.

5. Click Start, select Run, and type D:\EPSON (where D is your CD-ROM drive 
letter). Then click OK.

6. After a moment, the EPSON Stylus COLOR 740i Installer starts. Read the 
license agreement and click Agree.

7. Follow the on-screen instructions to install your printer driver and Status 
Monitor 2. 

8. When you restart your system after installing the printer software, leave your 
CD-ROM in the drive. You see the EPSON Stylus COLOR 740i Installer Main 
Menu after restarting. (If you don’t see the Main Menu, click Start, point to 
Programs, Epson, and click EPSON Stylus COLOR 740i Installer.)
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9. To install a program or your electronic EPSON Stylus COLOR 740i Manual, just 
click the button for your selection on the Main Menu. Then follow the on-screen 
instructions. Click EXIT when you’re done.

Note:

When you view your electronic manual, the installer automatically 
installs Adobe Acrobat Reader, if necessary. Once you’ve viewed 
the manual, you can copy it to your hard disk by selecting the Copy 
Printer Manual to Hard Drive option.

10. Some of the software you install may restart your system. If you restart but want 
to install more software, click Start, point to Programs, Epson, and select 
EPSON Stylus COLOR 740i Installer to return to the Main Menu.

11. After you finish installing Windows software, you’re ready to print a color image! 
See page 51 to get started.

Windows 3.1

1. Make sure your printer and computer are connected and turned off.

2. Turn on your printer and wait until the 

 

Ppower light stops flashing.

3. Turn on your computer and make sure Program Manager is running.

4. Insert your printer software CD-ROM.

5. Open the File menu and select Run. Type D:\EPSON (where D is your CD-ROM 
drive letter). Then click OK. 

6. Read the license agreement and click Agree. Then follow the on-screen 
instructions to install your printer driver.

7. After you finish installing software, you’re ready to print a color image! See 
page 51 to get started. For instructions on viewing your electronic EPSON Stylus 
COLOR 740i Manual and copying it to your hard disk, see “Viewing Your 
Electronic Printer Manual” on the next page.
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Viewing Your Electronic Printer Manual

Here are some quick guidelines for viewing your electronic printer manual using 
Adobe Acrobat Reader. Your creative software may also include electronic manuals; 
check their program folders or Help menu options to locate these manuals.

Note:

The electronic EPSON Stylus COLOR 740i Manual contains 
information on using the EPSON Stylus COLOR 740i printer with 
both Windows and Macintosh operating systems.

Opening Your Electronic Manual

How you open your electronic EPSON Stylus COLOR 740i Manual depends on your 
operating system and whether the manual is on your hard disk or CD-ROM drive.

If you already copied the EPSON Stylus COLOR 740i Manual to your hard disk and 
installed Acrobat Reader when you installed your printer software, do the following to 
view the manual:

■ Windows 95, 98, and NT 4.0: Click Start, point to Programs, EPSON, and 
click View EPSON Stylus COLOR 740i Manual. The manual opens in Acrobat 
Reader automatically.

■ Windows 3.1: Open File Manager and double-click the 740iDOC.PDF file. If the 
file doesn’t open, start Acrobat Reader, open the File menu, click Open and select 
the 740iDOC.PDF file. 

If you haven’t copied the manual to your hard disk, insert the printer software 
CD-ROM in your CD-ROM drive. Then follow the instructions below for your 
operating system:

■ Windows 95, 98, and NT 4.0: Click Start, select Run, and type D:\EPSON 
(where D is your CD-ROM drive letter). At the Main Menu, select View 
Electronic Documentation, then view and copy the manual by selecting the 
options on the next screen. When you view the manual, Acrobat Reader is 
installed automatically, if you don’t have it.
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■ Windows 3.1: To copy the electronic EPSON Stylus COLOR 740i Manual from 
your CD-ROM to your hard disk, use the Windows File Manager. Open the 
D:\MANUALS directory (where D is your CD-ROM drive letter) and locate the 
740DOC.PDF file. Copy the file to a directory on your hard disk.

If you don’t have Acrobat Reader, you must install it from the CD-ROM to view 
your electronic printer manual. Open the Program Manager File menu and select 
Run. Then type D:\ACROBAT\16BIT\ACRO16.EXE (where D is your CD-ROM 
drive letter).

Navigating an Electronic Manual

When you open an electronic manual, you’ll see this toolbar at the top:

There are several ways to navigate through electronic manuals:

■ Click on hot topics, which are usually underlined or displayed in a different color. 
To find out if a topic is hot, move your cursor over it. If the cursor turns into a 
pointing hand, the topic is hot—you can jump to it by clicking once.

■ If the manual has bookmarks, use the bookmark section on the left side of the 
screen to move quickly to the topic of your choice. Click the show bookmarks 
icon on the toolbar to see the bookmark section. (Some manuals may only have a 
table of contents that you can use to navigate the manual, if the topics are hot.)

■ Use the arrow buttons in the toolbar or the vertical scroll bar on the right side of 
the document to move through a manual. (The box to the left of the scroll bar 
displays the current page number.)

If you need more information, open Acrobat Reader’s Help menu and select the 
online guide.

next page

last page

previous page

show bookmarks first page
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Printing with Windows

1. Make sure your printer and computer are turned on.

2. Load a stack of plain paper with the printable side up and place it against the right 
edge guide. Then slide the left edge guide against the paper’s left edge, making 
sure the stack is lower than the arrow on the guide. If you are using letterhead or 
preprinted paper, be sure the top of the paper feeds into the printer first.

3. Open a Windows application program and select a document to print.

4. Open the File menu and click Print. You see the Print dialog box for your 
application (the Print dialog box for your application may look slightly different):

5. Make sure EPSON Stylus COLOR 740 is selected. (Although your printer is 
named the EPSON Stylus COLOR 740i, be sure to select EPSON Stylus 
COLOR 740 in your application’s print dialog box.) 

slide paper against the 
right edge guide

load paper only 
up to this arrow

if you see a Properties 
button, click it

if you see Setup, Printer, 
or Options, click that 
button instead; then click 
Properties in the next 
screen

make sure your printer 
is selected here
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6. If your application’s Print dialog box contains a Properties button, click 
Properties and go to step 7.

If you see a Setup, Printer, or Options button, click it. Then click Properties on 
the next screen.

In Windows 3.1, you won’t see a Properties button; just click Setup, Printer, or 
Options until you see the window in step 7.

7. Now you see the printer settings dialog box. If necessary, click the Main tab to 
display the settings shown below: 

Quality/Speed 
slider

Media Type 
setting

Automatic 
mode setting

Ink setting

Quality/Speed 
slider

Media Type 
setting

Automatic 
mode setting

Ink setting

Windows 95, 98, or NT

Windows 3.1
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8. Check the following settings:

■ Make sure the Media Type is set to Plain paper. (If you load a different type 
of paper, select the corresponding Media Type for it, as described on page 14. 
For instructions on loading special paper, see page 11.)

■ Make sure Ink is set to Color if you want to print in color.

■ Set the Mode option to Automatic. This is the easiest way to get good 
printing results for all kinds of documents, on all types of paper.

■ Move the Quality/Speed slider to the Quality setting. This selects high quality 
printing for your media. (The slider is not available for some media types. You 
can use a higher resolution on some papers on the Advanced [More Settings in 
Windows 3.1] dialog box; see page 15 for instructions.)

9. Click the Paper tab at the top of the dialog box if you need to change the paper 
size, number of copies, or page orientation.

Paper Size setting

Copies, Orientation, and 
Printable Area settings. 
Rotate by 180° is not 
available with Windows 3.1
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10. Click the Layout tab (not available with 
Windows 3.1) if you want to reduce or enlarge 
your printed image, print multiple pages on one 
sheet of paper, or add a watermark.

11. Click OK until you see the Print dialog box 
again.

12. Click OK to start printing. After a moment, the 
Progress Meter (Despooler in Windows 3.1) 
appears and shows the progress of your print 
job. You can cancel , pause , or 
restart your print job as necessary.

Note:

Your printer software CD-ROM includes a Guided Printing Exercise 
with step-by-step printing instructions. First install the PhotoMax 
software. To run the exercise, click the  EPSON Guided Printing 
Exercise icon on your desktop. Or click Start, select Programs, 
Polaroid PhotoMAX by ArcSoft, then click EPSON Guided Printing 
Exercise.

For more information on printing, see the electronic EPSON Stylus COLOR 740i 
Manual. See page 49 for instructions on viewing the manual.

Windows 95, 98, NT Windows 3.1
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Troubleshooting

This section contains Windows-specific troubleshooting information. For more help, 
see page 31 or see “Troubleshooting” in the electronic EPSON Stylus COLOR 740i 
Manual. 

If you want to verify your USB software installation on Windows 98 . . .

Check the Device Manager: Click Start, point to Settings, and click Control Panel. 
Then double-click System and click the Device Manager tab. You should see the 
device EPSON USB Printer Devices listed. Click the + next to the device; you should 
see EPSON USB Printer (EPUSB:1) listed.

If the printer doesn’t work correctly, uninstall the printer software as described on 
page 56. Also uninstall the EPSON USB Printer Device software the same way. Then 
reinstall the USB device and printer software as described in the previous section. If 
you still have problems, contact your EPSON dealer or EPSON technical support.

If you can’t see the ink level gauge when you print in Windows . . .

Make sure you installed Status Monitor 2. If you didn’t, uninstall your printer 
software, then reinstall it, making sure you choose to install Status Monitor 2. See 
page 56 for instructions on uninstalling your printer software. Once you’ve installed 
Status Monitor 2, make sure background monitoring is turned on. See your electronic 
EPSON Stylus COLOR 740i Manual for details on Status Monitor 2. (Status 
Monitor 2 is not available for Windows 3.1.)
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Uninstalling Printer Software

If you need to uninstall and reinstall your printer software, follow the steps for your 
operating system.

Uninstalling Windows 95, 98, or NT 4.0 Software

Caution:

If you uninstall and then reinstall the printer software, you must also 
uninstall and then reinstall Status Monitor 2 so it can recognize your 
printer. 

If you’re using Windows 98 with a USB connection, you must also 
uninstall and then reinstall the EPSON USB Printer Device 
software.

1. On your desktop, double-click My Computer, then double-click Control Panel.

2. Double-click Add/Remove Programs.

3. Click EPSON Printer Software in the program list.

4. Click the Add/Remove button and follow the instructions on screen. 

5. If Status Monitor 2 is installed, you need to uninstall it also. First, right-click the 
icon in the bottom-right corner of the taskbar and select Stop monitoring 

now to turn off background monitoring. Then return to Add/Remove 
Programs, select EPSON Status Monitor 2 in the program list, click the 
Add/Remove button, and follow the instructions on screen.

6. If you’re using Windows 98 with a USB connection, you need to uninstall the 
EPSON USB Printer Device software also. In the Add/Remove Programs 
window, select EPSON USB Printer Device in the list, click the Add/Remove 
button, and follow the instructions on screen.
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7. Restart your computer. 

8. Then reinstall your software:

■ Windows 98 with USB connection, see page 44

■ Windows 95, 98, or NT 4.0 with parallel connection, follow steps a through c 
below.

IMPORTANT:

If at any time you see a screen telling you that Windows has detected 
your printer and asking you to install a driver diskette, ALWAYS select 
Cancel. You can’t install your software that way.

a. Insert your printer software CD-ROM into your CD-ROM drive.

b. Click Start, select Run, and type D:\EPSON (where D is your CD-ROM drive 
letter). Then click OK.

c. After a moment, the EPSON Stylus COLOR 740i Installer starts. Click 
Re-install Printer Driver to install the driver and Status Monitor 2.

Uninstalling Windows 3.1 Software

1. Double-click the Main program group icon, then double-click the Control Panel 
icon.

2. Double-click Printers.

3. Select EPSON Stylus COLOR 740 in the Installed Printers list and click the 
Remove button.

4. To reinstall your software, see page 48.
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Index

A
Accessories, 40
Acrobat Reader, 7 to 8, 49 to 50
Aligning print head, 28
Automatic mode, 10, 53

B
Background printing, 11
Banding in printouts, 36
Bonus software, 1, 40

C
Cable, printer, 3, 41
Canceling print job, 11
Cleaning

print head, 19 to 21
printer, 29

Cleaning button, 31
Cleaning sheets, 14
Color Adjustment mode, 17
ColorSync, 16, 18
Control panel, 31 to 32
Creative software, 1, 40
Custom settings, 15 to 18

D
Despooler, Windows 3.1, 54
Diagnosing problems, 31 to 33
Digital Camera settings, 16, 17

Documentation, how to use, 2, 7 to 8, 
49 to 50

E
Economy setting, 16 to 17
Electronic manual, 7 to 8, 49 to 50
ENERGY STAR compliance, 4
Envelopes, 13
EPSON

Accessories, 40
help, 39 to 40
Monitor3, 11
papers, 11 to 14

Error Diffusion setting, 17

F
Features, 1
Fine Dithering setting, 17
Finest Detail setting, 17
Flip Horizontal setting, 17

G
Graph setting, 16

H
Halftoning, 17
Head Cleaning utility, 19 to 20
Help, 39 to 40
High Speed setting, 17
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I
Ink cartridge

replacing, 22 to 25
replacing outdated, 26 to 27
safety instructions, 5 to 6

Ink level gauge, Windows, 55
Ink setting, 10, 53

L
Layout, 11, 54
Lights, 31 to 32
Load/eject button, 31

M
Macintosh

printing with, 9 to 18
system requirements, 3

Maintenance, 19 to 29
Media Type setting, 10, 14, 53
MicroWeave setting, 17
Moving the printer, 30

N
Nozzle Check utility, 20 to 22

P
Paper

EPSON special, 11 to 14
loading, 9, 51
problems, 32
tab, Windows, 53
thickness lever, 13

Photo Paper, 12 to 13, 18

Photo Quality Ink Jet Paper, 13
PhotoEnhance3 setting, 16, 17
Preview, 11
Print head

aligning, 28
cleaning, 19 to 21

Print quality
problems, 36 to 38
setting, 17

Printer
cable, 3, 41
cleaning, 29
maintaining, 19 to 29
operation check, 33
power on/off, 4
transporting, 30

Printer software
CD-ROM, 1
troubleshooting, 34 to 35
uninstalling, 35, 56 to 57
updates, 31
using, 9 to 11

Printing
in Windows, 51 to 54
job status, 11
with custom settings, 15 to 18
with Macintosh, 9 to 11

Problem solving, 31 to 38
Progress Meter, Windows, 54
Project types, custom, 15 to 16

Q
Quality, see Print quality
Quality/Speed slider, 10, 53

R
Reader, see Acrobat Reader
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S
Safety instructions, 4 to 6
Service, 39 to 40
Software

bonus, 40
installer, 1
printer, 19 to 11, 35
problems, 34 to 35
uninstalling, 35, 56 to 57

Support, 39 to 40
System requirements

Macintosh, 3
Windows, 41

T
Technical support, 39 to 40
Testing printer, 33
Text setting, 16
Text/Graph setting, 16
Thickness lever, 13
Transporting printer, 30
Troubleshooting, 31 to 40, 55

U
Uninstalling software, 35, 56 to 57
USB

Macintosh, 3
Windows 98, 41, 55

Utilities
Head Cleaning, 19 to 20
Nozzle Check, 22
Print Head Alignment, 28

W
Watermark, 11, 54
Windows

Progress Meter, 54
system requirements, 41
troubleshooting, 55
uninstalling software, 56
USB, 41, 55

World Wide Web, 39

Y
Year 2000, 4
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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How to Order EPSON Ink and Paper

To order EPSON ink cartridges, paper, and other printing media, contact your dealer or 
call EPSON Accessories at (800) 873-7766 or visit our web site at www.epsonsupplies.com 
(U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral.

Ink Cartridges

Order these EPSON ink cartridges and use them within six months of installing them and 
before the expiration date on the package:

Black ink cartridge S020189
Color ink cartridge S020191

EPSON Papers

Paper name Size Part number

EPSON 360 dpi Ink Jet Paper Letter S041060

A4 S041059

EPSON High Quality Ink Jet Paper Letter S041111

A4 S041117

EPSON Photo Quality Ink Jet Paper Letter S041062

A4 S041061

Legal S041067

EPSON Photo Quality Ink Jet Cards 4.1 x 5.8 inches (A6) S041054

8 x 10 inches S041122

EPSON Photo Quality Glossy Paper Letter S041124

A4 S041126

EPSON Photo Paper 4 x 6 inches S041134

Letter S041141

A4 S041140

Panoramic S041145

EPSON Photo Stickers Kit (CD-ROM/paper)
EPSON Photo Stickers (refill)

4.1 x 5.8 inches (A6)
4.1 x 5.8 inches (A6)

S041144-KIT
S041144

EPSON Photo Quality Glossy Film Letter S041072

A4 S041071

4.1 x 5.8 inches (A6) S041107

EPSON Ink Jet Transparencies Letter S041064

A4 S041063

EPSON Photo Quality Self Adhesive Sheets A4 S041106

EPSON Iron-On Cool Peel Transfer Paper Letter S041153/S041155
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